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1.0 Introduction 
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©2008 ECD. All Rights Reserved. Printed in USA. US Products of ECD are covered by foreign and US Patents and 
Patents Pending. Information in this publication supersedes all previously published information. This Publication may 
not be translated and/or reproduced or stored in data retrieval system, or transmitted in any form or by any means 
without the express written permission of ECD. Specification and price change privileges reserved.  
 
The trapezoidal ECD logo®, and M.O.L.E.® (Multi-Channel Occurrent Logger Evaluator) are registered trademarks of 
ECD. MS-DOS and Windows are registered trademarks of Microsoft Corporation. IBM, IBM PC and PS/2 are 
registered trademarks of International Business Machines Corporation. 
 
While every precaution has been taken in the preparation of this document, ECD assumes no responsibility for errors 
or omissions, or for damages resulting from the use of information contained in this document or from the use of 
programs and source code that may accompany it. In no event shall ECD be liable for any loss of profit or any other 
commercial damage caused or alleged to have been caused directly or indirectly by this document. 
 
 

© 2006 Integration Associates Inc. All rights reserved. 
 
LIMITED USE LICENSE:  
By using this software, the user agrees to the terms of the following license. If the user does not agree to these terms, 
then this software should be returned within 30 days and a full refund of the purchase price or license fee will 
provided.  
Integration Associates hereby grants a license to the user on the following terms and conditions: The user may use, 
copy, modify, revise, translate, abridge, condense, expand, collect, compile, link, recast, distribute, transform or adapt 
this software solely in connection with the development of products incorporating integrated circuits sold by 
Integration Associates. Any other use for any other purpose is expressly prohibited with the prior written consent of 
Integration Associates. 
 
Any copy or modification made must satisfy the following conditions: 
1. Both the copyright notice and this permission notice appear in all copies of the software, derivative works or 
modified versions, and any portions thereof, and that both notices appear in supporting documentation. 
2. All copies of the software shall contain the following acknowledgement: "Portions of this software are used under 
license from Integration Associates Inc. and are copyrighted." 
3. Neither the name of Integration Associates Inc. nor any of its subsidiaries may be used to endorse or promote 
products derived from this software without specific prior written permission. 
 
THIS SOFTWARE IS PROVIDED BY "AS IS" AND ALL WARRANTIES OF ANY KIND, INCLUDING THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR USE, ARE EXPRESSLY DISCLAIMED. THE 
DEVELOPER SHALL NOT BE LIABLE FOR ANY DAMAGES WHATSOEVER RESULTING FROM THE USE OF 
THIS SOFTWARE. 
THIS SOFTWARE MAY NOT BE USED IN PRODUCTS INTENDED FOR USE IN IMPLANTATION OR OTHER 
DIRECT LIFE SUPPORT APPLICATIONS WHERE MALFUNCTION MAY RESULT IN THE DIRECT PHYSICAL 
HARM OR INJURY TO PERSONS. ALL SUCH IS USE IS EXPRESSLY PROHIBITED. 
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1.2 Declaration of Conformity 

Electronic Controls Design, Inc. 
4287-B S.E. International Way 
Milwaukie, Oregon U.S.A. 97222-8825 
(503) 659-6100 / (800) 323-4548  
FAX: (503) 659-4422 

 

 

Declaration of Conformity 
 
Product: MegaM.O.L.E.® Profiler Part number: E47-6342-45 

 MegaM.O.L.E.® 20 I/O Module  E47-6342-50 

 MegaM.O.L.E.® Power Pack Battery  E47-6342-30 
 
The above product is in conformity with the following standards or other normative 
documents: 

• EN 301 489-1 V1.6.1 (2005-09) 

• EN 300 328 V1.7.1 (2006-10) 

• EN 489-17 V1.2.1 (2002-08) 

• EN60950 
 
Following the provisions of the following European Directives: 

• R&TTE 1999/5/EC 

• Low-voltage Directive 2006/95/EC 

• RoHS 2002/95/EC 

• WEEE 2002/96/EC 
 
 

Signed:  Date: April, 2008 
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1.3 How to use this Users Help Guide 

This Users Help Guide explains how to use ECD Thermal Profiling instruments and 
software. 
 
This Users Help Guide is written for users of varied experience. If a section covers 
information you already know, feel free to skip to the next section. 

• You do not need to be a computer expert to use this Users Help Guide or the 
software. 

• The Users Help Guide assumes you are familiar with Microsoft® Windows® 
Operating Systems. 

 

Hardware portions of this manual are written to reflect the following firmware 
versions: 

• MEGAM.O.L.E.®: 10.27 and higher. 

The software portions reflect version(s) 2.11 and higher. 

 
The MEGAM.O.L.E.® MAP software is designed to be used with the ECD 
MEGAM.O.L.E.® and SuperM.O.L.E.® Gold Profilers. 
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1.4 Terms Used 

In 1986 ECD introduced our original Thermal Profiling instrument called the M.O.L.E.® 
(Multichannel Occurrent Logger Evaluator). Over the years ECD has produced 
several models of the M.O.L.E.® for use in a wide variety of applications. In this Users 
Help Guide, we may refer to all of our Thermal Profiling instruments as the M.O.L.E.® 
Profiler. 
 
The M.O.L.E.® Profiler is a registered trademark of ECD. 
 
The following statements describe special terms that will be used in this Users 
Help Guide: 

 
Informs the user that the note includes important information. 

 
Informs the user that the note includes a handy tip. 

 
Informs the user of an equation used. 

 
Hardware Terms: 

 
Informs the user that the note identifies conditions or practices that could 
result in damage to the equipment. 

 
Informs the user that the note identifies conditions or practices that could 
result in personal injury or damage to property other than the equipment. 

• Thermocouple, may be referred to as T/C. 

Software Terms: 

• Page Tab Views, the individual page tabs in the MEGAM.O.L.E.® software. 

• Data Set, multiple data runs saved as individual .XMG files into the selected 
working directory. 

• Data Run, the data uploaded from the M.O.L.E. Profiler and saved as an .XMG 
file into a working directory. 
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1.5 Fonts Used  

This manual uses a specific font to indicate terms or words that can be found directly on 
the display of the computer. 
 
For example: 
On the File menu, click Preferences to configure the software global settings. This font 
indicates the words File and Preferences are actually found on the computer display. 
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2. Safety 

 
2.1 Operators Safety Information 

The safety information in this section is for the benefit of operating personnel.  Warnings 
and Cautions will also be found throughout the manual where they apply.  
 
Hardware changes or modifications to the M.O.L.E. Profiler or components are not 
expressly approved by ECD and could void the warranty. 

 

The warranty will not cover damage caused by neglect or abuse of any ECD 
products. To maintain the safety features incorporated, operation must be in 
strict compliance with the requirements specified herein. 

 
The MEGAM.O.L.E.® Profiler complies with part 15 of the FCC Rules. Operation is 
subject to the following two conditions: (1) This device may not cause harmful 
interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation. 
 
For protection of the M.O.L.E. Profiler and components, observe the following: 

 

• NEVER permit the M.O.L.E. Profiler or the battery to exceed the maximum 
specified internal temperature as permanent damage may result. (Refer to 
Appendix A: Specifications). 

• NEVER expose the M.O.L.E. Profiler or battery to temperatures below the 
specified minimum for extended time periods. This may damage the 
rechargeable battery. 

• NEVER connect the M.O.L.E. Profiler input channels to objects at elevated 
electrical potentials. 

• NEVER operate the M.O.L.E. Profiler in flammable or explosive atmospheres. 
Such usage constitutes a fire or explosion risk. 

• NEVER immerse the M.O.L.E. Profiler in liquids. 

• NEVER subject the M.O.L.E. Profiler and components to sharp impacts. 

• NEVER excessively stress the computer Interface cable. 

• NEVER expose the M.O.L.E. Profiler and components to corrosive environments. 
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• NEVER make any changes or modifications to the Wireless RF components. 
Such changes are not expressly approved by ECD and could void the user's 
authority to operate the equipment. 

 

 

MEGAM.O.L.E.® Profiler is designed to be operated at a distance of greater 
than 20 centimeters from the head or torso of the user. 

 

 
When removing M.O.L.E. Profiler from any temperature environment, be 
careful of extreme temperatures and use protective gloves. 
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2.2 Battery Warnings 

 
Warnings: 

• Charge “Rechargeable” Power Pack batteries using only the ECD approved 
charger. 

• Always dispose of used batteries promptly and properly. 

• Keep all batteries away from children. 

• The batteries may explode if mistreated. 

• The batteries contain electrolytes. 

Replace the M.O.L.E. Profiler batteries with same type only: 

• MEGAM.O.L.E.: Rechargeable Power Pack battery, ECD Part No. (E47-6342-30) 

 
Using alternate batteries may present a risk of fire or equipment damage. 
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2.3 Equipment Maintenance 

Maintain your equipment to prevent future problems and unwanted costs. Keep your 
M.O.L.E. Profiler at peak performance by taking care of the system components and 
keeping it calibrated. 
 
Typical maintenance should include the following: 

• Wipe the exterior of the instrument enclosure or components with a cloth 
dampened with water or IPA alcohol. 

 

IPA alcohol is the only type of solvent that is acceptable to clean Thermal 
Profiling instruments or any of the system components. All other types such as 
organic solvents are not recommended. 

• Inspect the Power Pack battery charger enclosure for damage. Do not use the 
charger if the enclosure is cracked or broken, or if the power plug pins are loose 
or deformed. 

• ECD recommends the M.O.L.E. Profiler I/O Pod is factory re-calibrated every 6 
months when it is being used constantly. If the use is occasional, a period of no 
greater than 12 months between calibrations is recommended. 
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2.4 Product Symbols 

The following symbols may be present on the M.O.L.E. Profiler and/or system 
components: 

 
ON/OFF 

 
Start Data Run Recording 

 
Battery Level 

 

 
Operating Temperature 

 

Universal Serial Port (USB) 

 
Battery Charging Indicator 

 
Radio Frequency (RF) Activity 

 Radio Frequency (RF) Jack 

 

Waste Electrical and Electronic Equipment (WEEE) 
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Direct Current (DC) Power 

 
Alternating Current (AC) Power 

RoHS / 

 

RoHS Compliant 

 

CAUTION: Whenever this internationally recognized symbol is used on 
the product, additional information concerning that particular feature or 
function appears in the manual. 

 
European Conformity 

FCC Federal Communications Commission (FCC) 

 
Power transformer is protected throughout by double or reinforced 
insulation. 

 

 Indoor use only. For electric-shock protection, always operate the 
battery charger in a protected, indoor location. 
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3.0 Equipment 

 
3.1 MEGAM.O.L.E.® 

The MEGAM.O.L.E.® Profiler is the most compact and durable thermal profiling 
instrument ECD offers. It is powered by a removable Power Pack battery and includes a 
"Smart" I/O Pod that interfaces with the test assembly. 

 

Features/functions: 

• I/O Pod:This pod connects to the MEGAM.O.L.E. Profiler and has four input 
connections for attaching up to a maximum of twenty thermocouple sensors.  

• Main Module: This is the main controller which stores collected data runs. 
• Power Pack battery: Supplies power to the thermal profiler and I/O Pod. 
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3.1.1 I/O Pod 
This I/O Pod is considered a "Smart" pod as it is capable of storing all of the configured 
machine, assembly and process documentation. It also locks the data run  (How did we 
do it) documentation information and can remain with the test assembly for quick setup 
time. 

 

I/O Pod Features/functions: 

• Thermocouple/Inputs: This is where Type “K” Thermocouples sensors are 
connected. 

• Interface Connector: This connector is where converted digital data from the I/O 
pod is transferred when connected to the Main module. Since the I/O pod 
converts the recorded analog data to digital data, this reduces the amount of 
"Noise" the induced into the thermocouples measurement system. 

• Alignment Pins: These pins are used to secure the I/O Pod to the Main Module. 
They are keyed so it properly aligns with the Main module. 
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3.1.2 Main Module 
The Main module is the controller unit of the MEGAM.O.L.E. Profiler. This module 
stores the recorded data runs that can be downloaded to a computer through the Data 
Port located on the Power Pack battery.  

 

To configure and download data from the Main Module, the Power Pack 
battery must be connected to the unit. Refer to topic Power Pack Battery for 
more information. 
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Features/functions: 

• Buttons: ON/OFF, Record & OK. 

Button: Action: 
ON/OFF Turns Main module "ON/OFF". 
Record Starts/Stops Main module recording data. 
OK Invokes "OK" process where the last 

recorded profile is compared to pre-
configured criteria resulting in a "Pass" or 
"Fail" mode. 

 
• Activity indicators: These are LED's that indicate what state the M.O.L.E. 

Profiler is in. Refer to the illustration and table below. 
LED: Action: LED Color 
ON/OFF Indicates Main 

module is 
"ON" and idle 

Green 
(Flashing) 

Record Indicates Main 
module is 
recording data 

Green 
(Flashing) 

OK Indicates 
recorded 
profile passes 
pre-configured 
criteria using 
the Target 10-
OK tab in the 
software. 

Green - Pass 
(Solid) 
Red - Fail 
(Solid) 

Temp(erature) Indicates if the 
internal 
temperature is 
at or above a 
certain 
threshold. 

Red (Slow 
Flash) >40°C 
Red (Solid) 
>85°C 

Battery Indicates 
when the 
Power Pack 
battery voltage 
is low 

Red (Slow 
Flash) <3.0V 

RF (Radio 
Frequency) 

Indicates 
when main 
module and 
receiver is 
transferring 
data 

Blue 
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• Interface Connectors: There are two interface connectors in the Main module. 

The front connector interfaces with the I/O Pod and is where the converted digital 
data from the I/O pod is transferred to the Main module. The rear connector 
interfaces with the Power Pack battery and power and signal data is transferred. 

• Alignment Sockets: These are where the mating I/O Pod and Power Pack 
battery alignment pins are inserted. 

• RF Antenna Connector: This is where the Optional RF antenna is connected. 
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3.1.3 Power Pack Battery 
The MEGAM.O.L.E. Profiler is powered by a Power Pack battery and it is important to 
make sure it is charged and operating properly before each data run. When connected 
to a computer, the software displays the voltage of the Power Pack battery on the 
Status bar. Refer to topic Status Bar for more information. 

 

When the Power Pack needs to be charged use the transformer charger or USB 
computer interface cable supplied with the kit. Refer to the instructions in topic 
Charging the Power Pack Battery. It is recommended that a spare Power Pack 
battery be ordered so that one battery is charging while the other one is being used. 
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Features/functions: 

• Data/Charging Port: This port is located on the backside of the battery. This is 
used to transfer data through the USB computer Interface cable to the computer. 
It is also used to charge the battery using the supplied transformer. 

 
When the Power Pack battery is connected to a powered computer USB 
port, the power from the USB port will charge the Power Pack battery. 

• Activity indicator: This LED illuminates when the Power Pack battery is 
charging. 

• Interface Connector: This connector interfaces with the rear interface connector 
on the Main module. It is where the power and signal data is transferred. 

• Alignment Pins: These pins are used to secure the Power Pack battery to the 
Main Module. These are also keyed so it properly aligns with the Main module. 
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3.1.4 Sensors 
Up to 20 sensors can be attached to the MEGAM.O.L.E. Profiler per data run. Four sets 
of five 0.005” K-Type thermocouple sensors are included in the Kit. 

 

Bottom View Top View 

ECD also offers a wide selection of sensors and adaptors to meet 
the needs of many applications. For more information about 
optional sensors for specific applications, refer to topic How to 
Get Additional Help to contact ECD. 

 
Plug the sensor connector into the desired MEGAM.O.L.E. Profiler channel block. The 
software helps keep a record of the MEGAM.O.L.E.  Profiler channel number 
associated with the location and the type of sensor. The thermocouples correlate to the 
channels in the software so the sensors can be easy identified. 
 

 

The individual Thermocouples in the block connectors can be easily removed 
and replaced. Refer to topic Constructing a Thermocouple for more 
information. 
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3.1.5 USB Computer Interface Cable 
Two USB cables are included in the hardware package. These cables connect the 
MEGAM.O.L.E. Profiler to a computer USB port and power pack battery charger. 
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3.1.6 Barrier & Yellow Jacket 
The Uni-Barrier with Yellow Jacket is the standard barrier in all our Lead-Free profiling 
kits, including the wireless RF kit. A thermal barrier is the protection the M.O.L.E. needs 
to ensure longevity through harsh environments. With piano-hinged stainless steel 
construction, sheathed in cool-to the touch high-temperature fabric this thermal barrier 
is ideal for lead-free processes. This barrier is rated to protect the MEGAM.O.L.E. for 10 
minutes at 200C. When used with the Yellow Jacket it is rated for 17 minutes at 200C. 
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3.1.7 MEGAM.O.L.E.® to Standard T/C Adaptor 
This optional thermocouple adaptor is attached to the thermal barrier and converts the 
MEGAM.O.L.E.® profiler nano connectors to standard connectors. This is especially 
useful when a user has an experimental assembly pre-wired with standard 
thermocouples saving considerable setup time. 
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3.1.8 Wireless RF Option 
The wireless RF option for the MEGAM.O.L.E.® profiler produces real time profiles fast 
for immediate data collection and transmission to a computer. The Transmitter is an 
built-in component that when used with the antenna sends data to the RF transceiver 
which connects to a USB port on the computer. 
Wireless RF Transceiver: 

  

Front Side Back Side 

Antenna: 
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4.0 Basics 

 
4.1 Setup 

The Setup topic offers a brief description of the system hardware configuration. 
 
4.1.1 Charging the Power Pack Battery 
Because the M.O.L.E. profiler is powered by a rechargeable Power Pack battery, it is 
important that it is charged and operating properly prior to performing every experiment. 
A spare Power Pack battery may be ordered so the one battery is charging while the 
other one is being used. 
 
To charge the power pack battery: 

1) Slide the interchangeable plug into the adaptor until it clicks indicating that is fully 
seated. 

2) Plug the transformer end of the charger into a wall outlet and the USB connector 
end into the Power Pack. 

 

 

A completely discharged Power Pack takes about 8 hours to be fully 
charged. For quick charges, the Power Pack battery can be charged for 
15 minutes allowing one 10 minute data run to be performed. 

3) When the charging cycle is complete, connect the Power Pack to the M.O.L.E.. 
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The Power Pack battery can be charged continuously whenever the 
M.O.L.E. profiler is not being used, however, if the M.O.L.E. profiler is 
going to sit idle for five days or more, you may want to remove it from 
the charger. 
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4.1.2 Communications Setup 

To connect the M.O.L.E. Profiler: 

 
The software must be installed prior to communications setup. (Refer to 
Software Installation for more information). 

1) Insert the USB computer interface cable into a computer USB port and the other 
end into the Power Pack Battery Data Port. 
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The first time a M.O.L.E. Profiler is connected to a computer two drivers will be 
installed. One is a device driver for the M.O.L.E. Profiler and the other is for 
USB communication. 

2) During installation of the device driver, when prompted to select the location of 
the device driver, select "Install the software automatically". Follow the 
remaining wizard instructions closely. 

 

3) During installation of the USB driver a message box appears, select the 
Continue Anyway command button and the driver will be successfully installed. 
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4) After M.O.L.E. Profiler is connected to a computer, the software must be 
configured so they can communicate. Start the software program by either 
double-clicking the MAP software icon or selecting it from the ECD program sub-
menu. 

 

5) On the M.O.L.E. menu, click the Select Instrument command. 

6) Select the desired instrument from the list box. If there are none listed, click the 
Scan for Instruments command button to detect all available instruments.  

 

 

MAP software allows multiple instruments to be connected to a computer at 
one time. Selecting the Scan for Instruments command button will detect all 
instruments and display them in the list. If no instrument is detected, the 
default Demonstration MEGAM.O.L.E.® profiler is displayed. 

7) Click the OK command button to accept or Cancel to quit the command. 
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4.1.3 Wireless RF Option Setup 

To connect the wireless RF option: 

 

Prior to  wireless RF communication, the M.O.L.E. Profiler must first be 
connected to a computer through the USB port. This allows the software to 
register the M.O.L.E. Profiler ensuring that other local computers cannot read 
RF data from this profiler. (Refer to Communications Setup for more 
information) 

1) Insert the Wirless RF Transceiver into an available USB port and the antenna to 
the M.O.L.E. Profiler. The first time the Transceiver is connected to a computer, 
the drivers will automatically be installed. The operating system displays the 
installation status on the taskbar. 
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The M.O.L.E. Profiler is designed to work with with included antenna ECD P/N: 
E47-6342-11 only. Never make any changes or modifications to the Wireless 
RF components. Such changes are not expressly approved by ECD and could 
void the user's authority to operate the equipment. 

2) After the Transceiver is connected to a computer, it needs to be detected by the 
software to properly communicate. 
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3) Start the software program by either double-clicking the MAP software icon or 
selecting it from the ECD program sub-menu. 

 

4) On the M.O.L.E. menu, click the Select Instrument command. 

5) Select the desired instrument from the list box. If there are none listed, click the 
Scan for Instruments command button to detect all available instruments. 

 

When the software detects the Wireless RF Transceiver for the first time, the 
user will be prompted to enter the 5 digit Unlock Key located on the product ID 
label. 

 

6) Enter the Unlock Key in the field and select the OK command button. 

 

 

MAP software allows multiple instruments to be connected to a computer at 
one time. Selecting the Scan for Instruments command button will detect all 
instruments and display them in the list. If no instrument is detected, the 
default Demonstration MEGAM.O.L.E.® profiler is displayed. 
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7) Click the OK command button to accept or Cancel to quit the command. 

The system is now ready for Wireless RF communication. 
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4.2 Operation 

This section guides the user through a typical collection process. Portions of this section 
will require referral to some software sections of the Users Help Guide for additional 
information. 
 
The M.O.L.E. Profiler is dependent on the software to control how it collects and 
interprets data. Several kinds of data runs may need to be performed to achieve desired 
information, or the same data run may be performed repeatedly over time to monitor 
one process. Either way, an data run will need to be setup at least once. 
 
After the hardware is setup and the software is installed, use the following steps to 
perform an experiment using a M.O.L.E. Profiler. 

 
This procedure uses the "Fresh Start" wizard for the typical data run process. 

Step 1: Set MAP information 

1) Start the software by double clicking on the program icon. 

2) Connect the M.O.L.E. Profiler to the computer. Refer to topic 
Basics>Setup>Communications Setup for more information. 

 

When the information is being sent to a SuperM.O.L.E. Gold Profiler the 
Activity LED will illuminate indicating that it is communicating with the computer 
properly. 

3) Make sure the M.O.L.E. Profiler Power Pack battery is fully charged. When a 
M.O.L.E. Profiler is selected, the software status bar displays the current battery 
voltage. Refer to topic Software>Features>Status Bar for more information. 
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4) On the File menu, click New/Start. A message box appears with the three 
workflow wizard options. 

 

6) On the Start dialog box, click the Fresh Start command button and the workflow 
wizard appears. 

 

When navigating through the wizard, the step list on the left uses a color key 
to inform the user of the current step, steps that have been completed and 
remaining steps. 

 Current  Completed  Remaining
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7) Select the desired instrument from the list box to make active. If there are none 
listed, click the Scan for Instruments command button to detect all available 
instruments. 

 

MAP software allows multiple instruments to be connected to a computer at 
one time. Selecting the Scan for Instruments command button will detect all 
instruments and display them in the list. If no instrument is detected, the 
default Demonstration MEGAM.O.L.E.® profiler is displayed. 

 

8) Click the Next command button. 
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9) Select a machine from the Machine drop down list. If the desired machine does 
not appear in the list click the New command button to create a new machine. 
Refer to topic Software>Menus>Machine>Create new Machine for more 
information. 
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10) Set the machine recipe settings such as Conveyor Speed, Zone Temperatures 
and Temperature units. 

 

The software includes features to save and load machine recipe setting files. 
These files are helpful so the user can quickly recall machine information and 
ensure it is always the same. 

 

11) Click the Next command button. 

 

If no value is specified for the conveyor speed or the default oven temperature 
values, the software will remind the user to set them. 
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12) Enter the assembly information such as part number, board size, sensor 
locations and a product image.  

 

 

If a product image has been selected, clicking the Enlarge command button 
displays the Set Sensor Locations dialog box where the user can specify the 
locations of each sensor. To move sensor locations, drag the sensor markers to 
the approximate location where the sensors are attached. 
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13) When finished, click the OK command button to accept or Cancel to return 
without making any changes. 

14) Click the Next command button. 

15) Attach sensors to a test assembly. 

 

When soldering a T/C sensor to a component with high temperature solder, 
use Kester SN10 (or equivalent) for 183°C eutetic solder or Kester SN5 (or 
equivalent) for lead free soldering. 
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16) Unwind the sensor leads and attach the connectors to the M.O.L.E. Profiler. 
Make sure to connect them to the same channel(s) that were configured in the 
wizard workflow. For example, if configuring the M.O.L.E. Profiler to have 
Channels 1 through 5 active, be sure the sensors are attached to the same five 
channels. 

 
Kapton® tape, aluminum tape and Temprobe™ can also be used to hold T/C 
wire to the test assembly. 
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17) Select your process specification. The user can select a Paste from the database 
or a pre-defined Target 10 file. Then  select a Profile Type (Ramp-Soak-Spike or 
Ramp-to-Spike). If your Paste does not appear in the database list click the New 
command button to create a new paste. Refer to topic 
Software>Menus>Process>Create new Paste for more information. 

 

 

Once a paste is selected the specifications are displayed on the graph. The 
software also allows paste specification data to be viewed in a table view by 
clicking the Table command button. 
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18) Click the Next command button 
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19) Set Recording Parameters such as the instrument name, recording interval, start 
parameters and stop parameters. This step is where the user can also turn a 
sensor channel ON or OFF, set the sensor location description and sensor type. 
Refer to topic Software>Menus>M.O.L.E.>Set Recording Parameters for 
detailed information for each setting. 

 

20) Click the Next command button. 



♦47♦ MEGAM.O.L.E.® Help System Guide  

21) Click the Next command button to send the recording parameters to the 
instrument. 
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22) Click the Next command button. 
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Step 2: Perform Data Run 

1)  Place the M.O.L.E. Profiler in the appropriate thermal barrier making sure the 
Thermocouple and/or Sensor wires are not damaged. 

 

Never permit the M.O.L.E. Profiler to exceed the absolute maximum 
warranteed internal temperature, as permanent damage may result. The 
warranty will not cover damage caused by exceeding the maximum specified 
internal temperature. 

 

2) After the oven stabilizes, turn the M.O.L.E. Profiler on and press the record 
button. 

 

The record button will need to be pressed even if the M.O.L.E. profiler is 
configured to start if the start parameters Trigger Temperature or Points 
Delay are configured. 

3) Pass the thermally protected M.O.L.E. Profiler and test assembly through the 
machine. 
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It is highly recommended that protective gloves are used when retrieving the 
thermal barrier from the oven and when opening the thermal barrier. 

4) As the test assembly and M.O.L.E. Profiler emerge from the machine, carry the 
test assembly with sensors attached and the M.O.L.E. Profiler in the Thermal 
barrier to a table or flat surface. 

 
If a sensor is removed before the M.O.L.E. Profiler has stopped collecting data, 
the data for that channel might become distorted. 

5) Open the Thermal barrier and if the Activity LED is still flashing this means the 
M.O.L.E. Profiler is still recording and it must be stopped. 

6) Remove the M.O.L.E. Profiler from the Thermal barrier. Handle it carefully, as the 
case may still be warm. 

7) Disconnect the sensors from the M.O.L.E. Profiler and place it near the 
computer. 
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Step 3: Read Data Run 

1) Restore the software and click the Finish command button to read the data run 
from the M.O.L.E. Profiler. 

 

2) When the data run has been downloaded, the software will suggest a default file 
name or prompt the user to specify a new file name. 



MEGAM.O.L.E.® Help System Guide ♦52♦ 

I  

3) When finished, click the Save command button. 

4) The software then prompts the user if they want to enter Prediction mode. 
Entering prediction mode enables the user to change a zone temperature values 
or the conveyor speed and predict the outcome of that change on the data run 
profile. Refer to topic Software>Menus>Tools>Prediction for more information. 

 

5) Click the Predict command button to enter Prediction mode or Done to complete 
the workflow wizard . 

 
The information is automatically saved in the data run file (.XMG) and the experiment 
data can now be analyzed with the software tools. 



♦53♦ MEGAM.O.L.E.® Help System Guide  

5.0 Software 

 
5.1 Computer Hardware Requirements 

The following computer hardware requirements are necessary for the software to 
properly perform: 
 
Hardware: 

• 300mhz processor or equivalent 

• 128 megabytes of RAM (minimum) 

• 50 megabytes of free disk space 

• CD ROM 

• USB Port 

• 1024x768 VGA with True Color  

• Color printer is recommended 

Operating System: 

• Windows XP 

• Windows 2000 

Languages: 
MAP software is available in the following languages for the above operating systems: 

• English 

• Chinese Simplified 
 



MEGAM.O.L.E.® Help System Guide ♦54♦ 

5.2 Installation 

Autorun Install: 

1) Insert the CD in the drive and the MAP software autorun menu appears. 

 
If the autorun menu does not appear, proceed to Manual Install for 
instructions. 

2) Select the Install Software command button to start the installation. 

 

3) Closely follow the setup instructions provided with the software. 

 
The user must have administrator permissions for the computer to install this 
software. 
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Manual Install: 

1) Insert the CD in the drive. 

2) Select Run from the Start menu. 

3) Select the Browse command button and navigate to the software CD. Double-
click the installation (.EXE) file. 

4) Select the OK command button to start the installation. 

 

5) Closely follow the setup instructions provided with the software. 
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5.2.1 Starting the Software 

 
Prior to starting, click the README icon from the MEGAM.O.L.E.® program 
sub-menu to read the latest release notes 

After the software is installed, start the software program by double-clicking the 
MEGAM.O.L.E.® icon from the desktop. 

 

 

Once the software installation is complete, it is important to start the software 
and configure the software to communicate with the M.O.L.E. Profiler. Refer to 
topic Basics>Setup for more information. 
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5.2.2 Software Authorization 
The MEGAM.O.L.E.® software is a fully functional 31-day trial version. Once the trial 
period is over, you may purchase the software from an ECD Sales person. For Sales 
contact information refer to topic Service>How to Get Additional Help. 
 
To authorize: 

1) Start the software program by by double-clicking the MEGAM.O.L.E.® icon from 
the desktop and the Software Authorization dialog box appears. 

 

2) Enter the purchased Authorization key in the text box and click the OK command 
button. 

 

 

The software can also be activated from the Preferences property sheet. Refer 
to topic Software>Menus>File>Preferences>Misc>Authorization for more 
information. 

 



MEGAM.O.L.E.® Help System Guide ♦58♦ 

5.3 Features 

This section presents an overview of the software window. When the software is 
started, it automatically defaults to the previously selected working directory. Refer to 
topic Software>Menus>File>Open Working Directory for more information. 

 

After installation, the software is started a with the a sample working directory 
with files will be selected for users to familiarize themselves with the program. 
It is recommended when the user starts collecting process data, a new or 
exiting working directory should be used.  

The software offers several features as described in the following section. 

 

n Title Bar: This bar contains the program name, version, and the selected 
working directory.  

o Menus: These menus contain the commands and tools for all Page Tab Views. 
Each Page Tab View may contain different commands that supply specific 
support. Individual menus are described in detail in their specified sections. Refer 
to topic Software>Menus and Tool Commands for more information. 

p Toolbar: The Toolbar has buttons to serve as shortcuts to the menu commands. 
Individual toolbar buttons are described in detail in their specified sections of this 
manual. Each Page Tab View may have different items on the toolbar because of 
the different features offered. 
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q Page Tab Views: These tabs are used to gain access to each Page Tab View. 

r Split Bar: This bar slides the Horizontal Scroll bar to the left or right so all or part 
of the page tabs can be viewed. 

s Status Bar: This bar on the bottom of the display, shows the status of the 
M.O.L.E. Profiler Power Pack battery,  Internal operating temperature, connected 
COM port, available Help information, mouse pointer X-Y position, current date 
and time. 

t Scroll Bars: These bars scroll the display horizontally and vertically. 
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5.3.1 Page Tabs 
There are five standard Page Tabs. These tabs are located on the bottom left of the 
display. 

 

To display the contents of a Tab, use the mouse pointer. The tab will then become 
highlighted, and the worksheet will now be visible. 

 
The keyboard does not allow access to the Tabs. The only way to select a Tab 
is by using the mouse pointer. 
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5.3.2 Split Bar 
The Split bar lets the user slide the resize the Horizontal scroll bar to the left or right, so 
all of the Tabs can be viewed. This feature is always located on the left edge of the 
Horizontal scroll bar. 

 

 
Hidden Tabs may also be displayed by using the Tab Scroll Arrows located on 
the left side of the Tabs. 
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5.3.3 Status Bar 
This bar is located on the bottom of the software display. It shows the status of the 
M.O.L.E. Profiler Power Pack battery,  Internal operating temperature, connected COM 
port, available Help information, mouse pointer X-Y position, current date and time. 

 

Using the Preferences command, the user can decide which M.O.L.E. Profiler 
status bar items will be displayed. Refer to topic 
Software>Menus>File>Preferences>M.O.L.E. for more information. 

 

n Battery: This indicator displays the voltage reported by the currently selected 
M.O.L.E. Profiler. The nominal range for normal MEGAM.O.L.E. profiler 4.0V to 
3.0V. 

o Temperature: This indicator displays the internal operating temperature reported 
by the currently selected M.O.L.E. Profiler.  

 

If the internal operating temperature is within the acceptable range (0°-40°C 
[0°-104°F]) the symbol appears in GREEN. When the internal operating 
temperature is above the acceptable range (41°C> [105.8°F>]), it appears in 
RED indicating that the M.O.L.E. profiler has reached the temperature warning 
zone. 
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p M.O.L.E. Profiler Connection: This indicator displays a symbol for the computer 
communication connection type such as Serial, USB or wireless RF. 

q Instrument User Name: This indicator displays the user configured name for the 
M.O.L.E. Profiler. 

r Help Information: This indicator displays the action that button performs when 
the mouse pointer is placed over a Toolbar button or Menu command. 

s Time (X)/Temperature (Y) Readout: This indicator displays the Time and 
Temperature values of the mouse pointer location on the Profile tab Data Graph. 
The units displayed for Time and Temperature values are the same as those 
displayed on the graph. 

t Date and Time: This indicator displays the current time and date of the 
computer. The user can auto synchronize this clock with the M.O.L.E. Profiler 
internal clock. Refer to topic Software>Menu>File 
Menu>Preferences>M.O.L.E. for more information. 
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5.3.4 Scroll Bars 
All Tab Views have both Horizontal and Vertical screen scroll bars so the non-visible 
areas of the display can be scrolled into view. 
 
The Horizontal scroll bar is located in the lower right corner and can be scrolled left or 
right by pressing the left or right arrows located on each end of the scroll bar. 
 
The Vertical scroll bar located on the right side of the screen has the same features as 
the Horizontal scroll bar except it scrolls the display up and down. 

 

 

For best performance, it is recommended that the minimum computer display 
area be set to 1024 X 768. Refer to Microsoft® Windows® documentation for 
details. 
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5.4 Page Tab Descriptions 

The Page Tabs offer four different ways to view the data recorded by the M.O.L.E. 
Profiler. Each page tab focuses on specific data and offers different features and 
functions. Along with the Welcome page tab they formulate a complete Profiling report. 
 
5.4.1 Welcome Page Tab  
Welcome is the introductory tab. It contains an introductory illustration and text box for 
entering a company or profiling report name. 
 
Welcome Tab features: 

n Menus and Toolbar 

o Company/Report Name Text Box 
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5.4.1.1 Menus & Toolbar 

• Menus: File, Edit, Wizards, M.O.L.E.®, Machine-Oven, Assembly-Board, 
Process-Paste, Profile, Tools and Help. 

• Toolbar Buttons: Start, Open Working Directory, Save, Print, and Help. 
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5.4.1.2 Company/Report Name 
The text box located on the bottom half of the Welcome page tab allows the user enter 
a company or report name. 
 
To enter a name: 

1) Using the mouse pointer, click in the text box. 

2) Type a desired name and then hit the [enter] key to accept or [esc] to cancel. 
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5.4.2 Summary Page Tab 
The Summary Page Tab is where individual data runs are viewed in summarized page 
format. 
 
Summary Tab features: 

n Menus and Toolbar 

o Summary Template 
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5.4.2.1 Menus & Toolbar 

• Menus: File, Edit, Wizards, M.O.L.E.®, Machine-Oven, Assembly-Board, 
Process-Paste, Profile, Tools and Help. 

• Toolbar Buttons: Start, Open Working Directory, Save, Print, Help, First (data 
run of the data set), Back (to previous data run), Forward (to the next data run), 
and Last (data run of the data set). 
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5.4.2.2 Summary Template 

The Summary Page Tab is built using a template file (*.TSU) overlaid on a cell grid. 

 

 

The Summary template is automatically loaded every time the software is 
started. This template file is specified on the Summary page tab of the 
Preferences dialog box. Refer to topic 
Software>Menus>File>Preferences>Summary for more information. 

To display Template commands: 

1) Move the mouse pointer over a template cell. 

2) Using the right mouse button, right-click and a shortcut menu appears. 

 

Template commands can also be accessed on the View menu. Refer to topic 
Software>Menus>View>View Menu for more information. To add or edit a 
calculation refer to topic Software>Page Tabs>Summary Template>Add & 
Edit Content for more information. 
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3) You can now select from the following template commands. 
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5.4.2.2.1 Add & Edit Content 

To add or edit template content, the software includes a wizard to guide the user 
through the related content options. The template allows five different calculation 
categories to be displayed. 

Add & Edit Content wizards: 

n Text 

o Temperature Value (Y) 

p Time Value (X) 

q Slope (dX/dY) 

r Temperature (Y) Delta 

s Special Values 

 

This wizard contains all the related steps to add or edit content to the template. 
It is recommended to process all steps in order but the software allows you to 
navigate forward and backward setting options individually. When the minimum 
options have been selected, Finish command button will become active. 
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5.4.2.2.1.1 Text 
 
To add or edit Text content: 

1) Right-click a template cell and a shortcut menu appears. 

2) Select Add Content or Edit Content from the shortcut menu and the Add or 
Change a Calculation wizard appears. 

 

When navigating through the wizard, the step list on the left uses a color key 
to inform the user of the current step, steps that have been completed and 
remaining steps. 

 Current  Completed  Remaining
 

3) Click Text. 

 

4) Select the Next command button. 
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5) Select desired text formatting options. 

 

6) Select the Next command button. 
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7) Select desired cell border options. 

 

8) Select the Finish command button to complete the wizard and display the new 
calculation data in the selected template cell. 
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5.4.2.2.1.2 Temperature Value (Y) 

To add or edit Y-Axis Values content: 

1) Right-click a template cell and a shortcut menu appears. 

2) Select Add Content or Edit Content from the shortcut menu and the Add or 
Change a Calculation wizard appears. 

 

When navigating through the wizard, the step list on the left uses a color key 
to inform the user of the current step, steps that have been completed and 
remaining steps. 

 Current  Completed  Remaining
 

3) Click Temperature Values (Y) and which channel to derive the data from. 

 

4) Select the Next command button. 
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5) Select a Temperature (Y) Axis Value. 

 

If Temperature at Time Reference calculation is selected, the software 
requires the user to select an established Time (X) Reference line. If one is not 
established the software automatically creates one on the Profile Page Tab 
Data Graph. 

 

6) Select the Next command button. 
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7) Select the calculation constraints. These options are the specified area on the 
Time (X) Axis where the values are to be extracted from. 

 

If the Within Magnified Window constraint is selected and the Magnify tool is 
used to zoom in on a portion of the Data Graph, the Data Table displays the 
statistics for those values within the magnified window. 

 

8) Select the Next command button. 
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9) Select desired text formatting options. 

 

10) Select the Next command button. 
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11) Select desired cell border options. 

 

12) Select the Next command button. 
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13) Select Specification Limits and Units. If these values are violated colored bars 
will appear in the formatted template cell. Refer to  topic Software>Page 
Tabs>Summary>Template>Specification Limit Indicators for more 
information. 

 

14) Select the Finish command button to complete the wizard and display the new 
calculation data in the selected template cell. 
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5.4.2.2.1.3. Time Value (X) 

To add or edit X-Axis Values content: 

1) Right-click a template cell and a shortcut menu appears. 

2) Select Add Content or Edit Content from the shortcut menu and the Add or 
Change a Calculation wizard appears. 

 

When navigating through the wizard, the step list on the left uses a color key 
to inform the user of the current step, steps that have been completed and 
remaining steps. 

 Current  Completed  Remaining
 

3) Click Time Value (X) and which channel to derive the data from. 

 

4) Select the Next command button. 
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5) Select a Time (X) Axis Value. 

 

If any Temperature Reference (Y) calculation is selected, the software 
requires a Temperature (Y) Reference Line to be established. Refer to topic 
Add Temperature (Y) Reference Lines.  

 

6) Select the Next command button. 
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7) Select the calculation constraints. These options are the specified area on the 
Time (X) Axis where the values are to be extracted from. 

 

If the Within Magnified Window constraint is selected and the Magnify tool is 
used to zoom in on a portion of the Data Graph, the Data Table displays the 
statistics for those values within the magnified window. 

 

8) Select the Next command button. 
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9) Select desired text formatting options. 

 

10) Select the Next command button. 
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11) Select desired cell border options. 

 

12) Select the Next command button. 
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13) Select Specification Limits and Units. If these values are violated colored bars 
will appear in the formatted template cell. Refer to  topic Software>Page 
Tabs>Summary>Template>Specification Limit Indicators for more 
information. 

 

14) Select the Finish command button to complete the wizard and display the new 
calculation data in the selected template cell. 
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5.4.2.2.1.4. Slope (dX/dY) 

To add or edit Slope Value content: 

1) Right-click a template cell and a shortcut menu appears. 

2) Select Add Content or Edit Content from the shortcut menu and the Add or 
Change a Calculation wizard appears. 

 

When navigating through the wizard, the step list on the left uses a color key 
to inform the user of the current step, steps that have been completed and 
remaining steps. 

 Current  Completed  Remaining
 

3) Click Slope (dX/dY) and which channel to derive the data from. 

 

4) Select the Next command button. 
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5) Select a Slope Value. 

 

If Slope Between Time References calculation is selected, the software 
requires the user to select an established Time (X) Reference line. If one is not 
established the software automatically creates one on the Profile Page Tab 
Data Graph. 

 

6) Select the Next command button. 
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7) Select the calculation constraints. These options are the specified area on the 
Time (X) Axis where the values are to be extracted from. 

 

8) Select the Next command button. 
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9) Select desired text formatting options. 

 

10) Select the Next command button. 
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11) Select desired cell border options. 

 

12) Select the Next command button. 
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13) Select Specification Limits and Units. If these values are violated colored bars 
will appear in the formatted template cell. Refer to  topic Software>Page 
Tabs>Summary>Template>Specification Limit Indicators for more 
information. 

 

14) Select the Finish command button to complete the wizard and display the new 
calculation data in the selected template cell. 
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5.4.2.2.1.5. Temperature (Y) Delta 

To add or edit Temperature (Y) Delta content: 

1) Right-click a template cell and a shortcut menu appears. 

2) Select Add Content or Edit Content from the shortcut menu and the Add or 
Change a Calculation wizard appears. 

 

When navigating through the wizard, the step list on the left uses a color key 
to inform the user of the current step, steps that have been completed and 
remaining steps. 

 Current  Completed  Remaining
 

3) Click Temperature (Y) Delta and which channel to derive the data from. 

 

4) Select the Next command button. 
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5) Select a Y-Axis value delta calculation and which channels to you wish to be 
included in this calculation. 

 

6) Select the Next command button. 
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7) Select desired text formatting options. 

 

8) Select the Next command button. 
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9) Select desired cell border options. 

 

10) Select the Next command button. 
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11) Select Specification Limits and Units. If these values are violated colored bars 
will appear in the formatted template cell. Refer to  topic Software>Page 
Tabs>Summary>Template>Specification Limit Indicators for more 
information. 

 

12) Select the Finish command button to complete the wizard and display the new 
calculation data in the selected template cell. 
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5.4.2.2.1.6. Special Value 

To add or edit Special Value content: 

1) Right-click a template cell and a shortcut menu appears. 

2) Select Add Content or Edit Content from the shortcut menu and the Add or 
Change a Calculation wizard appears. 

 

When navigating through the wizard, the step list on the left uses a color key 
to inform the user of the current step, steps that have been completed and 
remaining steps. 

 Current  Completed  Remaining
 

3) Click Special Value. 

 

4) Select the Next command button. 
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5) Select a Special Value type. 

 

6) Select the Next command button. 
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7) Select desired text formatting options. 

 

8) Select the Next command button. 
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9) Select desired cell border options. 

 

10) Select the Finish command button to complete the wizard and display the new 
calculation data in the selected template cell. 
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5.4.2.2.2. Specification Limit Indicators 
Parameters displayed on the Summary Page Tab can have both Lower and Upper 
specifications applied. If a specification limit is violated, the software displays a red or 
blue indicator on the left edge of the Data Table cell. 
 
If a USL has been exceeded, that parameter indicator will appear in red (indicating it is 
above the specification limit). If a parameter is less than the user specified LSL, that 
parameter indicator will be appear in blue (indicating below the specification limit). 

 

 
Refer to topic Software>Page Tabs>Summary>Template>Add & Edit 
Content for information on how to apply LSL and USL values. 
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5.4.3. Spreadsheet Page Tab 
The Spreadsheet Page Tab contains data that is collected by the M.O.L.E. profiler put 
into standard spreadsheet format. Each row in the spreadsheet represents one data 
run. The columns after the Data Run and User defined Parameter Groups include SPC 
Flags so the user can select which parameters are to be displayed on the SPC Page 
Tab. 
 
Spreadsheet Worksheet features: 

n Menus and Toolbar 

o Spreadsheet Template 

p Parameters 

q SPC Flags 

r Data Run Rows 

s Selected Data Run 

t Filters 

u Statistics 
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5.4.3.1. Menus & Toolbar 

• Menus: File, Edit, Wizards, M.O.L.E.®, Machine-Oven, Assembly-Board, 
Process-Paste, Profile, Tools and Help. 

• Toolbar Buttons: Start, Open Working Directory, Save, Print, and Help. 
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5.4.3.2. Spreadsheet Template 

The Spreadsheet Page Tab is built using a template file (*.TSH) overlaid on a cell grid. 
Columns after the Data Run and User Parameter Groups allow the user to define 
parameters using the Template commands. To view the template use the horizontal 
scrollbar to slide the template left. 

 

 

The Spreadsheet template is automatically loaded every time the software is 
started.  This template file is specified on the Spreadsheet Page Tab of the 
Preferences dialog box. Refer to topic 
Software>Menus>File>Preferences>Spreadsheet for more information. 

To display Template commands: 

1) Move the mouse pointer over a parameter label. 

2) When the mouse pointer becomes a , right-click and a shortcut menu appears. 

 

Template commands can also be accessed on the View menu. Refer to topic 
Software>Menus>View Menu for more information. To add or edit a 
calculation refer to topic Software>Page Tabs>Spreadsheet>Spreadsheet 
Template>Add & Edit Content for more information. 
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3) You can now select from the template commands. 
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5.4.3.2.1. Add & Edit Content 

To add or edit template content, the software includes a wizard to guide the user 
through the related content options. The template allows four different calculation 
categories to be displayed. 

Add & Edit Content wizards: 

n Temperature Value (Y) 

o Time Value (X) 

p Slope (dX/dY) 

q Temperature (Y) Delta  

r Special Values 

 

This wizard contains all the related steps to add or edit content to the template. 
It is recommended to process all steps in order but the software allows you to 
navigate forward and backward setting options individually. When the minimum 
options have been selected, Finish command button will become active. 
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5.4.3.2.1.1. Temperature Value (Y) 
 
To add or edit Y-Axis Values content: 

1) Right-click a template cell and a shortcut menu appears. 

2) Select Add Content or Edit Content from the shortcut menu and the Add or 
Change a Calculation wizard appears. 

 

When navigating through the wizard, the step list on the left uses a color key 
to inform the user of the current step, steps that have been completed and 
remaining steps. 

 Current  Completed  Remaining
 

3) Click Temperature Values (Y) and which channel to derive the data from. 

 

4) Select the Next command button. 

5) Select a Temperature (Y) Axis Value. 

 

If Temperature at Time Reference calculation is selected, the software 
requires the user to select an established Time (X) Reference line. If one is not 
established the software automatically creates one on the Profile Page Tab 
Data Graph. 
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6) Select the Next command button. 

7) Select the calculation constraints. These options are the specified area on the 
Time (X) Axis where the values are to be extracted from. 

 

If the Within Magnified Window constraint is selected and the Magnify tool is 
used to zoom in on a portion of the Data Graph, the Data Table displays the 
statistics for those values within the magnified window. 
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8) Select the Next command button. 

9) Select desired text formatting options. 
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10) Select the Next command button. 

11) Select Specification Limits and Units. If these values are violated colored bars 
will appear in the formatted template cell. Refer to  topic Software>Page 
Tabs>Spreadsheet>Template>Specification Limit Indicators for more 
information. 
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12) Select the Finish command button to complete the wizard and display the new 
calculation data in the selected template column. 
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5.4.3.2.1.2. Time Value (X) 
 
To add or edit X-Axis Values content: 

1) Right-click a template cell and a shortcut menu appears. 

2) Select Add Content or Edit Content from the shortcut menu and the Add or 
Change a Calculation wizard appears. 

 

When navigating through the wizard, the step list on the left uses a color key 
to inform the user of the current step, steps that have been completed and 
remaining steps. 

 Current  Completed  Remaining
 

3) Click Time Value (X) and which channel to derive the data from. 

 

4) Select the Next command button. 

5) Select a Time (X) Axis Value. 

 

If any Temperature Reference (Y) calculation is selected, the software 
requires a Temperature (Y) Reference Line to be established. Refer to topic 
Software>Menus>Profile>Add Temperature (Y) Reference Lines.  
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6) Select the Next command button. 

7) Select the calculation constraints. These options are the specified area on the 
Time (X) Axis where the values are to be extracted from. 

 

If the Within Magnified Window constraint is selected and the Magnify tool is 
used to zoom in on a portion of the Data Graph, the Data Table displays the 
statistics for those values within the magnified window. 
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8) Select the Next command button. 

9) Select desired text formatting options. 
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10) Select the Next command button. 

11) Select Specification Limits and Units. If these values are violated colored bars 
will appear in the formatted template cell. Refer to  topic Software>Page 
Tabs>Spreadsheet>Template>Specification Limit Indicators for more 
information. 
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12) Select the Finish command button to complete the wizard and display the new 
calculation data in the selected template column. 
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5.4.3.2.1.3. Slope (dX/dY) 
 
To add or edit Slope Value content: 

1) Right-click a template cell and a shortcut menu appears. 

2) Select Add Content or Edit Content from the shortcut menu and the Add or 
Change a Calculation wizard appears. 

 

When navigating through the wizard, the step list on the left uses a color key 
to inform the user of the current step, steps that have been completed and 
remaining steps. 

 Current  Completed  Remaining
 

3) Click Slope (dX/dY) and which channel to derive the data from. 

 

4) Select the Next command button. 

5) Select a Slope Value. 

 

If Slope Between Time References calculation is selected, the software 
requires the user to select an established Time (X) Reference line. If one is not 
established the software automatically creates one on the Profile Page Tab 
Data Graph. 



MEGAM.O.L.E.® Help System Guide ♦120♦ 

 

6) Select the Next command button. 

7) Select the calculation constraints. These options are the specified area on the 
Time (X) Axis where the values are to be extracted from. 
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8) Select the Next command button. 

9) Select desired text formatting options. 
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10) Select the Next command button. 

11) Select Specification Limits and Units. If these values are violated colored bars 
will appear in the formatted template cell. Refer to  topic Software>Page 
Tabs>Spreadsheet>Template>Specification Limit Indicators for more 
information. 
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12) Select the Finish command button to complete the wizard and display the new 
calculation data in the selected template column. 
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5.4.3.2.1.4. Temperature (Y) Delta 
 
To add or edit Temperature (Y) Delta content: 

1) Right-click a template cell and a shortcut menu appears. 

2) Select Add Content or Edit Content from the shortcut menu and the Add or 
Change a Calculation wizard appears. 

 

When navigating through the wizard, the step list on the left uses a color key 
to inform the user of the current step, steps that have been completed and 
remaining steps. 

 Current  Completed  Remaining
 

3) Click Temperature (Y) Delta and which channel to derive the data from. 

 

4) Select the Next command button. 

5) Select a Y-Axis value delta calculation and which channels to you wish to be 
included in this calculation. 




